Solution Overview

Cisco Collaboration Systems Release 11.0/11.1
For your collaboration infrastructure, what if you could deliver a superior user
experience while simultaneously simplifying
administrator workload? We deliver all the
BENEFITS
capabilities you need in one unified product
 Make video conferencing more
consistent, intuitive, easy to use, and
portfolio.
simple to deploy.

 Expand collaboration beyond
desktop-to-mobile scenarios.
 Allow collaboration beyond corporate
boundaries by enabling connections
with external partners, consultants,
and customers.
 Help ensure interoperability with
existing investments by using
standards-based solutions.
 Provide flexible, cost-effective
deployment options.

Overview
Two employees from different offices are working together to
finalize a project. A vice president is video conferencing with
global investors. A team of service representatives is resolving
real-time issues to ensure optimal customer experiences.
These types of interactions happen every day across
organizations like yours. It takes a lot of people working
together to be successful—and they’re not always in the same
place at the same time. So it’s critical that you have the right
collaboration technology in place.

You need a collaboration infrastructure that is easy to manage.
You need communications endpoints that work for everyone. And you need it all to work wherever and whenever
your users want it.
Now that type of collaboration is eas ier to achieve than ever. Cisco ® Collaboration Systems Release (CSR) 11
provides a comprehensive set of infrastructure, applications, and endpoints. All designed, integrated, and validated
to deliver a superior user experience and a simplified administrato r workload. Whether deployed on premises, in
the cloud, or through a hybrid model, Collaboration Systems Releases support simple, productive, and cost effective collaboration, by anyone, anywhere, on any device.
CSR 11 is the latest in the ongoing evolution of our portfolio of collaboration products and solutions (Figure 1).
Building on prior releases, CSR 11 continues our focus on key qualities that matter to users —experience,
simplicity, and ubiquity.
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Figure 1.

Cisco Collaboration Systems Release 11 Delivers It All in a Unified Portfolio

For high-level information about Cisco collaboration systems, please visit Cisco Collaboration Systems
Documentation.

Collaboration Infrastructure
The Cisco collaboration core infrastructure has several key components, made up of products that have become
increasingly integrated over time: call control and session management, collaboration gateways, and unified
management. Together, these key components define and simplify a single end -to-end architecture for unified
communications and collaboration that provides the best possible experience for users and administrators.

Cisco Unified Communications Manager
IP private branch exchange (PBX) functions provided by Cisco Unified Communications Manager sit at the center
of the Cisco collaboration core infrastructure approach. They act as the glue that ties together and coordinates with
the other collaboration applications and devices in the Cisco collaboration portfolio. These PBX functions give you
the flexibility to connect users with the tools and resources they need to be effective in their jobs.
New with CSR 11.0 (Cisco Unified Communications Manager 11.0):
●

Enterprise groups and compliance for instant messaging and presence. Cisco Jabber® users can
search for groups in the Microsoft Active Directory and add them to their contact lists. If you update a group
that is already added to the contact list, the list is automatically updated.

●

Next-generation encryption. Cisco Unified Communications Manager supports Advanced Encryption
Standard (AES) 256 encryption of Session Initiation Protocol (SIP) signaling and media for endpoints that
also support it (such as the Cisco DX Series of endpoints with firmware release 10.2(4)).

●

Support for emergency calling. Emergency Call Handler helps you manage emergency calls in your
telephony network while following local ordinances and regulations. It provides essential emergency call
features and supports a limited number of locations with phone location assignment by static configuration.

●

Audio conference bridging. The Conference Now feature allows both external and internal callers to join a
conference by dialing a Conference Now interactive voice response (IVR) directory number, which is a
centralized conference assistant number. An IVR application guides the caller to join the conference by
playing announcements.

●

Opus codec support. Cisco Unified Communications Manager 11.0 supports the Opus audio codec.

Cisco Unified Attendant Console Standard
Cisco Unified Attendant Console Standard is a Microsoft Windows -based attendant console application for use with
Cisco Unified Communications Manager. It supports up to 5000 contacts on a s ingle instance.
New with CSR 11.0 (Cisco Unified Attendant Console Standard 11.0):
●

Support for Cisco Unified Communications Manager versions 9.0(1) through 11.0(1).

●

Additional contact fields displayed in the directory.
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●

Search for up to five directory fields, and directory search for accented characters using the nonaccented
equivalent; for example, typing “a” returns contacts that contain “ä” and “å.”

●

The File > Options > Configuration tab includes a Sync Now control that performs an on-demand
directory synchronization.

●

Editable unmapped fields for synchronized contacts.

●

Improved Busy Lamp Field accuracy for contacts using shared lines and extension mobility.

●

Caller ID name (if available) is displayed on incoming and active calls.

●

Dialable mobile and home phone numbers.

●

Pop-to-Front alerts display the application in front of all other open windows, even when it is not minimized.

Cisco Unified Attendant Console Advanced
Cisco Unified Attendant Console Advanced is a Microsoft Windows -based attendant console application for use
exclusively with Cisco Unified Communications Manager. Because the application emulates the functions of a
manual phone switchboard, it allows attendant console operators to quickly accept incoming calls and efficiently
dispatch them to recipients within an organization.
New with CSR 11.0 (Cisco Unified Attendant Console Advanced 11.0):
●

Support for up to 1000 system devices per server.

●

Support for Cisco Unified Communications Manager 9.0(x) to 11.0(1).

●

Support for Cisco Unified Communications Manager IM and Presence Service 9.0(x) to 11.0(1).

●

E.164 is supported for directory devices.

●

VMware ESXI 5.0 and 5.1 are supported.

●

The Cisco Unified Attendant Console Advanced client can be used with Job Access with Speech (JAWS)
screen-reading software versions 15 and 16.

●

System devices can be distributed among up to 100 queue device groups.

●

Citrix support now includes XenApp 7.6 and XenDesktop 7.6.

●

Improved parked calls display.

●

Support for Cisco IP Phone 7811, 8845, and 8865 and Cisco DX70 and DX80.

Cisco Collaboration Edge Architecture
Cisco Collaboration Edge Architecture offers users outside your firewall simple, highly secure access to all
collaboration resources, including video, voice, content, instant messaging, and presence. Using Cisco
Expressway, you can collaborate with people who are on third-party systems and endpoints or in other companies.
It also allows teleworkers and Cisco Jabber mobile users to work more effectively on their devices of choice. In
addition to the Cisco Jabber soft client, this architecture supports an expanding range of endpoints, most recently
including the Cisco DX Series of collaboration endpoints, as well as the Cisco IP Phone 7800 and 8800 Series.
New with CSR 11.0 (Cisco Expressway X8.6):
●

Desktop sharing from Lync. Cisco Expressway now supports desktop or application sharing from Lync
clients to conference participants using Cisco collaboration endpoints.

●

License bypass for calls to Cisco Collaboration Meeting Rooms (CMR). Cisco Expressway no longer
requires Rich Media Session (RMS) licenses for calls to and from cloud-based Cisco CMRs. This includes
SIP calls between the collaboration cloud and the CMR hybrid solution. (There is no license bypass for
CMR Premises calls. H.323 calls to cloud-based CMRs still consume licenses.)
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●

New codec support. Cisco Expressway now supports the H.265 video and Opus audio codecs. The
codecs are supported in SIP traversal calls (that is, calls where Cisco Expressway is handling the media
streams).

●

Mobile and Remote Access (MRA) support for new endpoints (preview). MRA is being expanded to
include Cisco DX Series endpoints and the Cisco IP Phone 7800 and 8800 Series.

New with CSR 11.1 (Cisco Expressway X8.7):
●

Dial via Office-Reverse (DVO-R) through MRA. DVO-R handles call signaling and voice media
separately. All call signaling, including the signaling for MRA on Expressway, traverses the IP connection
between the client and Unified Communications Manager. Voice media traverses the cellular interface and
hairpins at the enterprise public switched telephone network (PSTN) gateway. Moving audio to the cellular
interface helps ensure high-quality calls and securely maintained audio, even when the IP connection is
lost.

●

Lync screen sharing through a gateway cluster. Expressway X8.7 extends this feature to work on a
cluster of gateway Expressway peers, so that a greater number of screen-sharing sessions can be
simultaneously transcoded.

●

MRA with Cisco IP Phone 7800 and 8800 Series and DX Series. MRA is now officially supported on the
Cisco IP Phone 7800 and 8800 Series when the phones are running firmware version 11.0(1) or later. We
recommend Expressway X8.7 or later for use with these phones.
◦ Cisco IP Phone 8800 Series
◦ Cisco IP Phone 7800 Series
MRA is officially supported with the Cisco DX Series endpoints running firmware version 10.2.4(99) or later.
This support was announced with Expressway version X8.6.
◦ Cisco DX650
◦ Cisco DX80
◦ Cisco DX70

Cisco Prime Collaboration
Cisco Prime™ Collaboration gives you simplified, unified management across voice and video networks, which
lowers operating expenses and helps ensure a superior quality of experience for the user. The solution offers
automated, accelerated provisioning for the entire Cisco Unified Communications System and real -time monitoring
®

and proactive troubleshooting across Cisco Unified Communications and Cisco TelePresence solutions—all in
one integrated product.
With Cisco Prime Collaboration, you can significantly accelerate site rollouts and dramatically reduce the time
required for ongoing changes. So you get increased productivity while lowering operating expenses. In addition, by
significantly simplifying moves, additions, changes, and deletions (MACDs), the solution makes it simple to
delegate these tasks, allowing you to optimize IT resources and further reduce total cost of ownership. With
support for both IP phones and Cisco TelePresence endpoints, Cisco Prime Collaboration further streamlines and
simplifies the system administrator’s work.
Cisco Prime Collaboration Provisioning features include automated processes for Cisco Unified
Communications and Cisco TelePresence day-1 initial deployments and for day-2 MACDs. An intuitive user
interface provides a single view of a subscriber and the subscriber's services, as well as a consoli dated view of
subscribers across the organization.
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New with CSR 11.0 (Cisco Prime Collaboration Provisioning 11.0):
●

New user interface. Cisco Prime Collaboration Provisioning has a new user interface to provide a better
user experience.

●

Batch management enhancements. Batch scheduling and management improve administrator
productivity.

●

Common template. You can use the common template for several endpoint models or lines. This reduces
the number of templates to manage and choose from at order time.

●

Improved endpoint management. You can add or update endpoints by uploading the endpoint file (a zip
file containing a list of supported endpoints). The Endpoint Bundles pane displays a table with the list of
endpoints that are available in the system and their supported Cisco Unified Communications Manager
versions. These details about endpoints are automatically updated in the table based on the endpoints
added to Cisco Prime Collaboration Provisioning.

●

Infrastructure object enhancements. The following are supported through Batch Provisioning:
◦ Feature group
◦ Softkey templates
◦ IVR service parameters
◦ Computer telephony integration (CTI) route point line (change)
The Cisco Unified Communications Manager 11.0 Conference Now and Emergency Location (ELIN) group
features are supported through Batch Provisioning and the user interface.

●

Unified communications device support. The following versions of the Cisco Unified Communications
devices are newly supported:
◦ Cisco Unified Communications Manager 11.0
◦ Cisco Unity® Connection 11.0
◦ Cisco Unified Communications Manager IM and Presence Service 11.0
◦ Cisco Unified Communications Manager Express 11.0
◦ Cisco Unity Express 11.0

Cisco Prime Collaboration Assurance provides management for Cisco voice and video collaboration systems
through a single, consolidated view. This includes continuous, real -time monitoring and advanced troubleshooting
tools for Cisco collaboration applications and endpoints, such as Cisco Unified Communications Manager, Cisco
TelePresence Video Communication Server (VCS), Cisco Unified Contact Center, Cisco TelePresence, and so on.
As an add-on to the Assurance module, Cisco Prime Collaboration Contact Center Assurance offers monitoring
and diagnostics for the Cisco Unified Contact Center Enterprise deployment.
Cisco Prime Collaboration Analytics provides historical reporting of key performance indicators (KPIs) and helps to
analyze trends for capacity planning, resource optimization, and quality of service. It also helps track collaboration
technology adoption rates in the network and provides metrics to help analyze how users are actually using the
collaboration endpoints daily.
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New with CSR 11.0 (Cisco Prime Collaboration Assurance 11.0):
Cisco Prime Collaboration Assurance Advanced 11.0 provides the following:
●

New user interface. Improved user interface menu items offer a simplified navigation scheme.

●

Dashboards
◦ A Customer Voice Portal (CVP) License Usage dashlet under the License Usage dashboard allows you
to view license usage for Cisco Unified CVP call servers.
◦ A Contact Center Enterprise License Usage dashlet under the License Usage dashboard lets you view
the list of devices, their capabilities, and the number of agents logged in to them.
◦ You can view the Severely Conceal Seconds Ratio (SCSR), Conceal Seconds R atio (CSR), Conceal
Seconds, and Severely Conceal Seconds values in the Call Details pane of the Call Quality
Troubleshooting page.
◦ The OpsView dashboard is enhanced to display the hard and soft unregistered endpoints count as a
separate entity.
◦ You can view the cumulative utilization of the conference bridges for each conductor pool in your network
from the Conductor Bridge Pool Utilization dashlet. This dashlet is available as a tab on the Utilization
Monitor page.
◦ You can view a new set of performance counters loaded for Cisco Finesse ® and Cisco SocialMiner®
devices with version 11.0.

●

Reports
◦ Voice call quality grading is performed based on the SCSR percentage in the following reports: call detail
records and call management records reports, Network Analysis Module (NAM) and sensor reports, and
voice call quality event history reports.
◦ The call detail and call management reports are simplified to enhance the user experience. You can filter
these reports by using the Display filter panel.

●

Monitoring and Diagnostics
◦ Session monitoring is supported for Collaboration Edge meetings and includes topology construction of
MRA endpoints for point-to-point, multipoint, and multisite sessions.
◦ You can cross-launch Cisco Prime Infrastructure features for devices that are managed in both Cisco
Prime Infrastructure and Cisco Prime Collaboration applications to perform network diagnosis and
troubleshooting for a session.
◦ Cascading of Cisco TelePresence servers enables you to monitor the servers during ad hoc conference
calls over Cisco TelePresence Conductor.

Cisco Prime Collaboration Assurance Standard 11.0 provides the following new features:
●

New user interface. A new interface provides a better user experience.

●

General support. Cisco Prime Collaboration Assurance Standard 11.0 supports the following:
◦ Cisco Unity Connection 9.x and later
◦ Cisco TelePresence Management Suite 9.x and later
◦ Cisco Unified Communications Manager 9.x and later
◦ Cisco Unified Communications Manager IM and Presence Service 9.x and later
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Cisco Prime Collaboration Analytics provides the following new features:
●

New user interface. A new interface provides a better user experience.

●

License Usage dashboard. This dashboard helps you track the license usage of applications such as
Cisco Unified Contact Center Enterprise and Cisco Unified CVP.

●

My Dashboard. You can create a custom dashboard of your choice and add any existing dashlets to it.

Cisco Prime Collaboration Contact Center Assurance provides the following new features:
●

New user interface. A new interface provides a better user experience.

●

Dashboards:
◦ You can view the Contact Center Enterprise License Usage dashlet under the License Usage dashboard
to see the list of devices, their capabilities, and the number of agents logged in to them.
◦ You can view the CVP License Usage dashlet under the License Usage dashboard to view license
usage for Cisco Unified CVP call servers.

Cisco Business Edition 7000
Built on the virtualized Cisco Unified Computing System ™ (Cisco UCS®) platform, the Cisco Bus iness Edition 7000
(BE7000) is equipped with premium collaboration applications for voice, video, mobility, messaging, conferencing,
instant messaging and presence, and contact center. Turn them on as your collaboration needs increase, and
easily scale your users and devices by deploying additional BE7000 servers. The modular building -block design of
the BE7000 is ideal for deployments of several hundred users to tens of thousands of users, providing plenty of
room for future growth.

Cisco Business Edition 6000
Cisco Business Edition 6000 (BE6000) is a family of purpose -built, all-in-one, packaged collaboration solutions that
are ideal if your company has between 25 and 1000 employees. Each BE6000 package solves complex
communications challenges with one affordable platform that’s easy to deploy, manage, and use. The BE6000 is
scaled to the needs of small businesses and midmarket customers. A configure -to-order process simplifies
ordering and deployment.

Cisco Unity Connection
Cisco Unity Connection is a robust unified messaging and voicemail solution that has flexible message access
options and simplified IT management. With this solution you can access and manage messages from an email
inbox, web browser, the Cisco Jabber platform, Cisco IP phone, smartphone , or tablet. Cisco Unity Connection
also provides flexible message access and delivery format options, including support for voice commands, speechto-text transcription, and even video greetings.
New with CSR 11.0 (Cisco Unity Connection 11.0):
●

Improved notifications. The Summary Notification feature allows end users to receive summary
notifications of their voice messages in an email message. The Missed Call Alert feature allows end users
to receive missed call alerts in an email message.

●

Video greetings for call handlers and auto-attendants. Video greetings are now supported with call
handlers.

●

Increased Cisco Jabber client scalability. Cisco Unity Connection 11.0(1) and later offer increased Cisco
Jabber client support.
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Conferencing
Cisco video conferencing products give you scalable and affordable conferencing no matter how big —or small—
your business is. By simplifying delivery and use of video conferencing, you can increase the return on your
investment. Flexible deployment models support your existing endpoints and allow you to take best advantage of
new ones.

Cisco TelePresence Server
With Cisco TelePresence Server, you get intuitive, business-quality video conferencing. It resides at the core of the
Cisco collaboration infrastructure portfolio, enabling on-premises Cisco CMR deployment with Cisco Unified
Communications Manager, Cisco TelePresence Conductor, and Cisco TelePresence Management Suite (TMS).
New with CSR 11.1 (Cisco TelePresence Server 4.2):
●

Multiparty license mode. Cisco TelePresence Server Release 4.2 introduces a multiparty license mode.
This allows you to administer multiparty licenses centrally on Cisco TelePresence Conductor instead of
having to load screen licenses locally on each server.

●

Conductor support without an encryption key. This release introduces support for Cisco TelePresence
Conductor without the need for an encryption feature key. Cisco TelePresence Conductor requires
Transport Layer Security (TLS) for SIP communication with the Cisco TelePresence Server, and as such
the encryption feature key was needed to enable TLS. Now TLS for HTTP and SIP is available without the
need for the encryption feature key.

●

Change default administrator credentials on first login. This release introduces a security improvement
that requires the default administrator credentials to be changed on first login. No functionality or
configuration is possible on the server until the default administrator credentials have been changed.

●

New serial command: reset_config_preserving_keys. This release introduces a new serial command to
simplify and speed up the process of restoring a unit to its factory settings.

●

Cisco TelePresence Server on Multiparty Media 410v and 820. For increased scale and improved costeffectiveness, Cisco TelePresence Server takes advantage of new hardware platforms. The Cisco
TelePresence Server on Multiparty Media 410v (MM410v) is based on the latest Cisco UCS servers,
including the Cisco UCS C220 M4 Rack Servers and B200 M4 Blade Servers. Up to eight MM410v blades
can be mounted in a 6-rack-unit (6RU) Cisco UCS 5108 Blade Server Chassis for industry-leading port
density. The increased scale of these new offerings simplifies the system administrator’s job in meeting your
organization’s video conferencing requirements. The Cisco TelePresence Server on Multiparty Media 820 is
a new, high-performance conferencing blade for the Cisco TelePresence MSE 8000 Series chassis,
supporting the advanced features of the latest versions of Cisco TelePresence Server software.

Cisco TelePresence Conductor
Cisco TelePresence Conductor software simplifies multiparty video collaboration. It orchestrates the allocation of
conferencing resources for every user in a meeting, so user experiences are always consistent, no matter the user,
meeting type, or endpoint. By enabling increased scale and reducing the administration effort, Cisco TelePresence
Conductor makes conferencing management easy.
New with CSR 11.0 (Cisco TelePresence Conductor XC4.0):
●

Multiparty licenses. This new Cisco TelePresence Server licensing model is user-based instead of screenbased. Two types of multiparty licenses are supported:
◦ Personal Multiparty (PMP): Each license is assigned to a specific user. PMP licenses are suitable for
users who start conferences frequently.
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◦ Shared Multiparty (SMP): Each license is shared by multiple users, but only in one conference at a time.
SMP licenses are suitable for users who start conferences infrequently.
To support multiparty licensing, connections between Cisco TelePresence Conductor and the conference
bridges must use HTTPS. (We recommend HTTPS in any case.)
Multiparty licensing requires the following product versions:
◦ Cisco TelePresence Management Suite 15.0 or later
◦ Cisco TelePresence Management Suite Provisioning Extension (TMSPE) 1.5 or later
◦ Cisco TelePresence Server 4.2 or later
●

Fully qualified domain names (FQDNs) for additional IP addresses for LAN 1. An FQDN is required for
additional IP addresses if you want to use a public certificate authority to sign the Cisco TelePresence
Conductor certificate. We recommend that you configure Cisco TelePresence Conductor by adding ad hoc
and rendezvous addresses to the public certificate.

●

Cisco TelePresence Server encryption key no longer required. An encryption key is no longer required
to use version 4.2 or later. The message on the Conference Bridge Status page has changed from
“Encryption key installed” to “Signaling encryption enabled.” Before Cisco TelePresence Server version 4.2,
signaling encryption was enabled only if the encryption key was installed. The term “encryption key” is
replaced with “media encryption key” beginning in version 4.2. Most customers outside of Russia will still
want to install this key. Encryption keys installed in servers running a software version earlier than 4.2 are
automatically converted to media encryption keys when upgrading to version 4.2 or later.

New with CSR 11.1 (Cisco TelePresence Conductor XC4.1):
●

Usage report. A new Usage Report page (Maintenance > Diagnostics > Usage report) lets you
download a log file that contains usage information. Up to 10 GB of log entries can be stored and remain
available for download. Logging is automatically enabled and runs when events take place. Available
download formats include CSV, XML, and JSON. The report is designed to help you determine everyday
bridge utilization and hourly usage.

●

Conference placement settings. This setting on the new Global Settings page (Conference
configuration > Global settings) allows you to specify how Conductor selects bridges. Choose the option
that corresponds to the most common type of conference in your company.
◦ Favor Scheduled: Selects the bridge with the fewest conferences currently in progress (better for
conferences that start at the same time). This is the default setting.
◦ Favor CMRs: Selects the bridge with the most spare capacity (better for conferences with staggered start
times).

●

Support for Active Meeting Manager in TMSPE. Conference hosts can now control their Personal CMRs
using Active Meeting Manager in TMSPE, providing a user-friendly alternative to using the endpoint control
panel and replacing the capabilities of Conference Control Center in Cisco TelePresence Management
Suite.
Note:

●

Scheduled meetings are not currently supported with Active Meeting Manager.

SIP domain override settings. If you are using a deployment that does not include a TMSPE, you can
configure the SIP domain on the new Global Settings page (Conference Configuration > Global
settings). When a SIP call comes in, the Conductor IP address or FQDN will be re placed with the
configured SIP domain. The results will be matched against the configured aliases. (Example:
1234@conductor_ip/1234@conductor_fqdn becomes 1234@configured_sip_domain)
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Cisco TelePresence Management Suite
Cisco TelePresence Management Suite offers you flexible, intuitive scheduling tools for conferences across the
range of the Cisco collaboration infrastructure portfolio, including Cisco Unified Communications Manager, Cisco
TelePresence Server, Cisco TelePresence Conductor, and Cisco CMR. Cis co TelePresence Management Suite
comprises several related products:
●

Cisco TelePresence Management Suite

●

Cisco TelePresence Management Suite Extension for Microsoft Exchange (TMSXE)

●

Cisco TelePresence Management Suite Provisioning Extension (TMSPE)

New with CSR 11.0 (Cisco TelePresence Management Suite 15.0, TMSXE 5.0, TMSPE 1.5):
●

Moved audit log settings. We have improved application security by moving the following settings to Cisco
TMS Tools:
◦ Administrative Tools > Configuration > General Settings > Enable Auditing
◦ Administrative Tools > TMS Server Maintenance > Audit Log data purge settings

●

Improved Cisco TelePresence Management Suite performance. The overall performance has been
significantly improved by running Internet Information Server (IIS) Application Pool in 64-bit mode.

●

Removed checking of client certificates. “Request Client Certificates for HTTPS API” has been removed
from Transport Layer Security Options in Cisco TMS Tools > Security Settings > Advanced Security
Settings.

●

Early join for scheduled point-to-point calls. Participants in a point-to-point conference may now be able
to join five minutes prior to the scheduled time. This lets the Join button appear for all types of participants
in a conference.

●

Preferred call protocol option. The administrator can choose between H.323 and SIP as the call protocol
when routing a conference.

●

Configurable user credentials to add CE. It is possible to use nondefault credentials (other than the
administrator) for customer edge (CE) software endpoints in Cisco TelePresence Management Suite for
communication. You can edit passwords of CE endpoints for the credentials that are currently used. This
changes the password on the endpoint and makes Cisco TelePresence Management Suite use the new
password.

●

Improved communication security. For enhanced secure communication, two security settings have
been merged into a single new setting, Communication Security. Now you can set the level of
communication security to medium, medium-high, or high for all connections of Cisco TelePresence
Management Suite.

New with CSR 11.1 (Cisco TMS 15.1, TMSXE 5.1, TMSPE 1.6):
●

New email template. User experience has been enhanced by introducing a new template for booking invite
and meeting cancellation emails. It is made responsive for all types of email clients in various operating
systems, such as iOS, Android, and Windows. The previous template is renamed “legacy template” and the
new template is used as the default template in the current version of Cisco TelePresence Manageme nt
Suite.

●

Meeting information page. Added for host and participants in all ongoing and upcoming meetings. The
following meeting information is available on the page:
◦ Joining information: Contains information that a participant can use to join the meeting.
◦ Rooms and participants: Lists the participants in the meeting.
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◦ Meeting details: Lists the details of the meeting.
◦ A link to set advanced meeting options in the Cisco TelePresence Management Suite Booking user
interface.
●

Location information field. A new Location field has been added in Cisco TMS > Booking > New
Conference. It can be used by the organizer to display the physical location(s) of the conference. The
values, available in the Location field in Microsoft Outlook, are displayed in this field for th e deployments
that use Cisco TMSXE 5.1.

●

Dial-in number allocation. The dial-in number allocation behavior has been improved for meetings that are
edited.

Cisco TelePresence Content Server
The Cisco TelePresence Content Server simplifies the process of capturing and sharing many types of content
throughout your organization, including lectures, training sessions, meetings, and any critical events.
With Cisco TelePresence Content Server, your organization can record and stream high-quality video and content
for live and on-demand access. You can also distribute your content, live or recorded, to any PC or portable media
®

device or to Cisco Show and Share .

Collaboration Endpoints and Clients
Cisco endpoints range from IP phones and video endpoints to desktop, mobile, and web clients.

Cisco IP Phone 7800 and 8800 Series
The Cisco IP Phone 7800 Series provide reliable, full-featured, and affordable voice communications. The 8800
Series offers additional user features, including support for Cisco Intelligent Proximity for sharing contacts and call
history from the user’s personal mobile device. With CSR 11.0, the newest members of the 8800 Series also
support video collaboration.
New with CSR 11.1 (endpoint software version 11.0):
●

More debugging options. Debugging options have been enhanced for the Cisco IP phones. When
administrators experience a phone problem that they cannot resolve, they can enable debugging for the
phone, reproduce the problem, and send the logs to the Cisco Technical Assistance Center (TAC) for
analysis. Administrators can also implement multilevel and multisection support for the parameters.

●

Official support for MRA through Expressway. MRA provides a way for remote workers to easily and
securely connect into the corporate network without using a VPN client tunnel. The feature uses TLS to
secure network traffic.

Latest Generation of Cisco TelePresence MX Series Endpoints
The latest generation of Cisco TelePresence MX Series endpoints provides high-quality video collaboration in just
about any room. The MX300 G2 and MX200 G2 are value products within the MX Series of collaboration room
endpoints, and the MX700 and MX800 represent the performance line within the portfolio. Both combine beautiful
design and powerful functions into all-in-one solutions for meeting room deployments.
New with CSR 11.1 (endpoint software version CE8.0):
●

Cisco Intelligent Proximity. Allows users to connect their PC, MAC, iOS, or Android device to an endpoint
wirelessly. Depending on what services have been enabled for Intelligent Proximity, users can get locally or
remotely shared content to their Android and iOS devices, and/or access endpoint call control. When
Intelligent Proximity is connected with the Cisco Proximity app for PC or Mac, users can wirelessly share
images of their laptop screen locally if the system is not in a call, and remotely if the system is in a call.
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●

Multistream. Enhances the user experience while in a conference with multiple participants. The main
benefits of this feature are:
◦ A two-screen system (that is, Cisco TelePresence MX700 and MX800 Dual) will be able to use both
screens for video participants when participating in a multistream-enabled conference.
◦ Layout control is more flexible and can be selected on the endpoint locally. This experience is enhanced
when using a two-screen system.

Cisco TelePresence SpeakerTrack 60
The Cisco TelePresence SpeakerTrack 60 is a dual-camera system for room -based video endpoints. One camera
quickly locates the active speaker and presents a close-up of that speaker. At the same time, the other camera
gets ready to seek and display the next active speaker. The result is very fast camera switching and an
uninterrupted meeting experience.

Cisco DX Series Endpoints
The Cisco DX Series is an innovative set of multifunction touchscreen devices. With these endpoints you can
launch lifelike HD video meetings with any standards-based H.264 Advanced Video Coding (AVC) device,
®

including smartphones, Cisco TelePresence systems, and Cisco WebEx and video-enabled Cisco Jabber
applications. Use these phones as you would a Cisco IP phone to run presence, instant messaging, and Android
applications, all on a single, easy-to-use device.
New with CSR 11.1 (endpoint software version 10.2.5):
●

Access to call statistics. There is now a shortcut to display call statistics on screen during a call.

●

CA trust list update. For a DX Series device to authenticate an Expressway certificate and establish a TLS
session, the Expressway certificate must be signed by a public certificate authority (CA) that is trusted by
the DX Series firmware. It is not possible to install or trust other CA certificates on DX Series devices for
authenticating an Expressway certificate. (See http://www.cisco.com/c/en/us/support/collaborationendpoints/desktop-collaboration-experience-dx600-series/products-technical-reference-list.html for the
current list of supported CA certificates.)

●

Contacts search. Users can now search for and call contacts from the corporate directory from the Calls
tab.

●

Default wallpaper (DX650 only). The default wallpaper folder has changed to Desktops/1569x600x24/
Wallpapers that were pushed to the device before this release still display on the device, unless it is factory
reset. A DX650 with the 10.2(5) load that is registered to Cisco Unified Co mmunications Manager receives
the wallpaper from the communications manager only if the wallpaper is in the Desktops/1569x600x24/
folder (and the Background Image field is set properly in the communications manager).

●

HDMI audio. Audio from a PC that is connected to the HDMI port of a DX Series device will play through
the device's speakers. During a call, the audio from the PC will be mixed with the audio received from the
call. During a call with a presentation, audio from the PC will be shared on the call .

●

SIP URI. Users can now tap a SIP URI to start a call from applications such as Meetings or Email.

●

Stay in PC mode. While users are working in PC mode, they receive calls in a picture -in-picture (PiP)
window. If they use Cisco Jabber desk-phone control mode, they can also make calls from the Cisco Jabber
application on their PC and have it appear in a PiP window. The PiP works for both audio and video calls,
includes a keypad, and can be expanded to full screen.
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Cisco TelePresence IX5000 Series Endpoints
The Cisco TelePresence IX5000 Series is a triple-screen video collaboration system that offers the market's most
vivid immersive collaboration experience today.
New with CSR 11.0 (endpoint software version 8.0.5 and 8.0.6):
●

Improved video quality. Software release 8.0.5 improves IX5000 Series system video quality by
enhancing the gradual decoder refresh (GDR) feature for H.264 calls.

●

Software release 8.0.6 extends support for dual-tone multifrequency (DTMF) tones.

New with CSR 11.1 (endpoint software version 8.1):
●

Improved user experience. Software release 8.1 provides an improved user experience on the Touch10
panel, and provides support for Intelligent Proximity (call control features and the ability for users to receive
content on iOS and Android devices).

Cisco Intelligent Proximity for Mobile Voice
Cisco Intelligent Proximity is a suite of features that activate when users bring their mobile devices within proximity
of select Cisco voice and video collaboration endpoints. It allows users to synchronize mobile devices wirelessly to
accomplish tasks such as importing contacts and call histories. It also lets users move the audio from a mobile
phone to a different endpoint when they get closer to thes e endpoints.

Cisco TelePresence SX80 Codec and SX10 Quick Set
The Cisco TelePresence SX80 Codec provides a powerful and flexible platform for creating the ultimate video
collaboration experience. Built with integration in mind, the SX80 supports flexibility and creativity for customized
video collaboration rooms. Cisco offers three SX80 integrator packages to reduce the need for external equipment
and the overall cost of deploying video in larger meeting rooms. The packages include:
●

SX80 Codec and PrecisionHD camera: 1080p4x for smaller room scenarios

●

SX80 Codec and Precision 60 Camera for larger room scenarios: Currently the best image quality in the
market

●

SX80 Codec and the SpeakerTrack 60 dual-camera system, which features an innovative, direct, and fast
switching approach for active speaker tracking

Meanwhile, the Cisco TelePresence SX10 Quick Set is an all -in-one unit that combines with any flat-panel display
to video-enable small collaboration spaces.

Cisco Jabber
The Cisco Jabber solution lets users access presence, instant messaging, voice, video, voice messaging, desktop
sharing, and conferencing. Now they can find the right people, see if and how they are available, and collaborate
using their preferred method.
The Cisco Jabber application is available on a range of user devices —Microsoft Windows and Mac OS X
computers, Apple iOS devices, and devices running the Google Android operating system. These versions of the
application have a consistent feature set and a similar design so that users have a c onsistent experience
regardless of the device they are using.
With the latest version, a single click of the mouse can escalate a multiparty instant messaging conversation into
a multiparty video conference, hosted on Cisco TelePresence Server, a Cisco Web Ex meeting, or Cisco CMR
Cloud.
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New with CSR 11.0:
All Cisco Jabber 11.0 versions:
●

Enhanced conferencing: Cisco CMR Cloud and Cisco WebEx Personal Room. Within a group chat, a
user can escalate an instant messaging conversation to an audio and video conference using Cisco CMR
Cloud or Cisco WebEx Personal Rooms.

●

Far-end camera control (FECC). For devices that support it, users can direct cameras on the other end of
video calls and control the screen layout during conference calls. An icon is displayed in calls using
cameras with FECC that they can use to pan, tilt, and zoom the far-end camera. This feature is available
only in softphone mode.

●

DTMF digit management. While on a call, a user can cut and paste DTMF digits to enter a PIN. You can
also include DTMF digits with your protocol handlers to create links that participants can use to quickly
access their meetings.

●

Opus audio codec support. The Cisco Jabber platform supports the Opus codec for audio capabilities.
This feature requires Cisco Unified Communications Manager IM and Presence Service Version 11.0.

Cisco Jabber 11.0 for Windows:
●

IBM Notes contact search. Users can now search for and add local IBM Notes contacts to their contact
lists.

●

Jabber to Jabber calling. Provides basic voice and video calling between Cisco Jabber clients without
Cisco Unified Communications Manager registration. This feature applies to cloud dep loyments only.
Jabber to Jabber calling is supported only for users who authenticate to the Cisco WebEx Messenger
service.

●

Persistent chat-room features. Users can search directly from persistent chat rooms; escalate persistent
chat-room conversations to audio and video conferencing using Cisco CMR, Cisco WebEx Personal
Rooms, or other conferencing solutions; and share their screens with other participants in a persistent chat
room.

●

Click-to-call features. A user can make a Cisco Jabber call using an administrator-defined global keyboard
shortcut that is active from any application on their desktop. And the Cisco Jabber application now supports
registering as the click-to-call URI handler.

●

Instant messaging only share: Groups of 10. Users can now share their screens from an instant
message with groups of up to 10 Cisco Jabber for Windows users.

Cisco Jabber 11.0 for Mac:
●

Persistent chat-room support. Search directly from persistent chat rooms.

●

URI links in chat window. Enter URL links in the chat window, and chat participants can click the links to
start calls and chats.

Cisco Jabber 11.0 for iOS and Android:
●

G.722 audio codec. Support for this codec enhances voice communication for voice over IP (VoIP) calls.
This wideband audio codec, which delivers a superior call experience, is a default codec for calls to Cisco
IP desk phones and other portfolio endpoints.

●

Flexible DSCP and separate port range. Administrators can use flexible differentiated services code point
(DSCP) to assign different priorities to audio and video streams. Also, administrators can set separate port
ranges for audio and video on the SIP profile.
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●

Publish location information. Users can add their location information on the Cisco Jabber client for their
contacts to see. To show the location, they configure the Location Enabled parameter. They can customize
the settings in the Options menu.

New with CSR 11.1:
All Cisco Jabber 11.5 versions:
●

Message broadcast. Allows users to send a single IM to multiple contacts. Users can select multiple
contacts or a group of contacts from their contact list and send a broadcast message to all of them at once.
Recipients receive broadcast IMs in the same way as normal one-to-one chats.

●

Multiple device messaging (cloud). Users who are signed in to multiple devices can now see all sent and
received IMs on each device, regardless of which device is active. Notifications are synchronized; if an IM is
read on one device, it shows as read on other signed-in devices

Cisco Jabber for Windows Release 11.5:
Chat and Presence
●

Chat alert sound menu. Users can change the default alert sound to a preconfigured sound or add their
own sound file. Instructions on how to add new sound files are in the Cisco Jabber for Windows 11.5
User Guide.

●

Mentions in chat window tray. If mentions are enabled, users can use the new Mention button in the chat
window tray to mention users in chat rooms.

●

Remember open conversations on sign-in. Each time users sign in to the client, the person-to-person
conversations (maximum 30 conversations) that were open when they signed out can be restored.

●

Chat with federated contact from search results. Users can now chat with and call federated contacts
without having to first add them as contacts.

●

Choose destination folder for chats and file transfers. Users can now specify their own folder
destination for saved chats and file transfers.

Telephony
●

Jabber to Jabber calling. Provides basic voice and video calling between Cisco Jabber clients without
Cisco Unified Communications Manager registration. Jabber to Jabber calling is supported only for users
who authenticate to the Cisco WebEx Messenger service.

●

Deskphone video extended to Windows 10. Deskphone video is now supported on Microsoft Windows
10.

●

Browser click to call: Internet Explorer, Google Chrome, and Mozilla Firefox. Users can now start a
call directly from a browser by highlighting a phone number and choosing to call the number or call with edit.

Sharing Enhancements
●

Select screen to share. Users with multiple monitors can select which screen to share during screen
sharing.

Contact Enhancements
●

Contact card on hover split button. Contact cards are displayed when users hover over a contact's name
in the Contacts list. If a contact has more than one phone number, a split cal l button is now shown on the
contact card.

●

Contact card on search. Contact cards can now be displayed when users hover over contact names in a
search result.
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●

Contact search on IBM Notes. Users can now search for and add local IBM Notes contacts to their
contact lists.

Cisco Jabber for Mac Release 11.5:
Calling Features
●

Hunt groups. Enable incoming calls to be directed to a group of users. The call route is based on several
factors, including first available, longest idle, broadcast hunting, and circular hunting. You can use Cisco
Jabber and desk phones to answer hunt group calls.

●

Call pickup. Allows users to pick up incoming calls from their own group. Group Call Pickup and Directed
Call Pickup allow users to pick up incoming calls to another group or individual, respectively. You can use
Cisco Jabber and desk phones to answer call pickup calls.

●

Personal ringtone. Users can select a ringtone for incoming calls from a menu of distinctive ringtones for
their client in the Preferences window.

●

Call with edit. This menu option is available from the main window by right-clicking over a contact's name.
When users select a number from this menu option, the call number is copied into the Search or Call field.
Users can edit the number before making the call.

●

Extend and connect. Users can use the client to do the following:
◦ Make and receive calls on a third-party IP phone in the office.
◦ Control a third-party IP phone in the office, such as hold or resume.
◦ Control a home or hotel phone when connecting with Expresswa y for MRA.

Chat and Presence Features
●

Restore chats on sign-in. When users sign in to the client, the chat sessions that were open when the
user signed out of the client are restored. This feature applies to one-to-one chats.

●

Alert when available. Users can set the client to notify them when a contact becomes available.

●

Locations. Create, define, and display locations in the client for your contacts to see.

●

Persistent chat rooms:
◦ Administration and management. Administrators can now create and delete rooms, manage
membership, and moderate rooms. Define room moderators who can create or remove rooms, add or
remove members, and define room types and descriptions.
◦ Room discovery and enrollment. View joined rooms, browse through a list of available rooms, join o pen
rooms, and request membership of members-only rooms.
◦ Persistent chat rooms are applicable to on-premises deployments only.

●

Logout inactivity timer. This timer allows you to automatically log users out of the client after being
inactive for a specified amount of time.

Cisco Jabber for Android Release 11.5:
●

Enhanced OS support:
◦ Cisco Jabber is supported on the Android 6.0 Marshmallow OS.
◦ Cisco Jabber is supported on all Android Wear that has Android OS 5.0 or later and Google Play service
8.3 or later.

●

Bluetooth controls in Jabra Motion headset. Users can answer and end a Cisco Jabber call using
Bluetooth controls on a Jabra Bluetooth headset with firmware version 3.72 or later.
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●

Security improvements:
◦ Administrator-controlled inactivity timer. The inactivity timer automatically logs out users from Cisco
Jabber after a specified period of inactivity.

Cisco Jabber Guest
Browser-based Cisco Jabber Guest allows users to click a link in a website and immediately experience high quality, real-time communications. Users can range from one-time interactions with customer service or sales
departments, including remote experts, to general-purpose, frequent interactions with customers, partners, and
suppliers.

Customer Collaboration
The Cisco Customer Collaboration portfolio provides capabilities to differentiate your business by:
●

Routing contacts to the most appropriate and available agent based on your own business rules and
objectives.

●

Streaming call-event and customer-profile information directly to your agents’ desktops for more personal
interactions with customers.

●

Incorporating social media to proactively respond to customers on Twitter, Facebook, and other public
forums or blogging sites.

●

Supporting mobile customers through innovative integrations with mobile applications, including video
interactions, to deliver service the way customers prefer.

●

Providing contact center managers and supervisors with detailed reports and dashboards showing agent
productivity and customer service levels.

●

Generating reports specific to the management of your contact center business based on an enterprisewide
view of timely and accurate data.

Cisco Unified Contact Center Enterprise
Cisco Unified Contact Center Enterprise delivers intelligent contact routing, call treatment, network -to-desktop CTI,
and multichannel contact management over an IP infrastructure. It combines automatic call distributor (ACD)
functions with IP telephony in a unified solution, allowing your company to rapidly deploy a distributed contact
center infrastructure.
New with CSR 11.0 (Cisco Unified Contact Center Enterprise 11.0):
●

Platform updates. In release 11.0, Cisco Unified Contact Center Enterprise now requires Microsoft
Windows 2012 R2 Standard Edition and Microsoft SQL Server 2014 64 -bit Standard or Enterprise Edition.

●

ESXi Release 5.5 support. Support for ESXi Release 5.5 Update 2 is now available.

●

Live Data. This release extends support for Live Data from Cisco Packaged Contact Center Enterprise to
include Cisco Unified Contact Center Enterprise.

●

IPv6 support. Cisco Unified Contact Center solutions can now support IPv6 connections for agent and
supervisor Cisco Finesse desktops and phones. Your IPv6-enabled deployment can use either IPv6 only or
a mix of IPv4 and IPv6 endpoints. Servers that communicate with those endpoints can now accept IPv6
connections in addition to IPv4 connections. Com munications between those servers and contact center
Central Controller nodes continue to use IPv4 connections.

●

Contact sharing. Contact sharing allows you to scale beyond 12,000 agents by routing calls to two Cisco
Unified Contact Center Enterprise instances.
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●

Precision queue enablement in a hybrid deployment. System administrators can create precision
queues for routing and queuing to Cisco Unified Communications Manager agents in a Cisco Unified
Contact Center Enterprise hybrid deployment.

●

Failover enhancements. Outstanding dialogs terminate in the router during failure scenarios for Type 10
Voice Response Unit (VRU) peripherals. This process helps make sure that the system does not attempt to
use and reserve agent resources without the ability to deliver a call.

●

Endpoints for agents and callers. This release includes support for the following endpoints:
◦ Cisco IP Phone 7821, 7841, and 7861
◦ Cisco IP Phone 8811, 8841, 8851, 8861, 8845, and 8865
◦ The 8845 and 8865 models have video capability.

Cisco Unified Contact Center Express
Cisco Unified Contact Center Express delivers a highly secure, available, virtual, and sophisticated customer
interaction management solution for up to 400 agents. This integrated, comprehensive contact center solution is
intended for both formal and informal contact centers in midmarket, enterprise branch office, and corporate
departments.
New with CSR 11.0 (Cisco Unified Contact Center Express 11.0):
●

Email enhancement. This feature allows the agent to discard email. Appropriate histori cal reports have
been enhanced to provide information regarding the number of discarded emails.

●

Cisco Finesse IP Phone Agent. Cisco Agent Desktop is deactivated in Release 11.0(1). Cisco Finesse IP
Phone Agent provides a replacement for Cisco Agent Desktop IP Phone Agent.

●

Outbound enhancement. This feature allows outbound campaigns to have duplicate contact entries so
that contacts can be called multiple times within the same day.

●

Standalone Unified Intelligence Center. This feature allows Cisco Unified Intelligence Center to be
installed on a standalone server that is connected to Cisco Unified Contact Center Express to provide
support for multiple data sources and custom reporting.

●

Cisco Unified Intelligence Center reporting enhancements. This feature introduces enhancements to
Live Data gadgets and historical reports to improve the user experience.

●

Post-call treatment. Post-call treatment allows Cisco Unified Contact Center Express to provide treatment
to an Interactive Call Distribution (ICD) call once the agent ends the call from the Cisco Finesse Desktop.
Post-call treatment can be used for use cases such as transferring the call to a survey for customer
feedback.

Cisco Finesse Agent and Supervisor Desktop
The Cisco Finesse Agent and Supervisor Desktop is designed to provide a collaborative experience for the various
communities that interact with your customer service organization. This next-generation desktop helps improve the
customer experience while offering a user-centric design to enhance customer care representative satisfaction.
New with CSR 11.0 (Cisco Finesse Agent and Supervisor Desktop 11.0):
●

Sign-in URL now requires FQDN. To sign in to the Cisco Finesse administration console or agent
desktop, enter the FQDN of the Cisco Finesse server in the URL. If you enter the server IP address or
hostname, Cisco Finesse redirects your browser to the server FQDN.
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●

Multiple call-variables layouts. In previous releases, Cisco Finesse supported only one default call variables layout. With Release 11.0(1), the Call Variables Layout gadget allows you to define up to 200
unique call-variables layouts (one default layout and 199 custom layouts) to displa y on the Cisco Finesse
agent desktop.

●

Cisco Finesse IP Phone Agent. With Cisco Finesse IP Phone Agent (IPPA), agents can access Cisco
Finesse capabilities on their Cisco IP phone as an alternative to accessing them through the browser. The
phone agent does not provide the full set of Cisco Finesse features that are supported using the browser,
but it does allow agents and supervisors to receive and manage Cisco Finesse calls if they do not have
access to a PC.

●

Accessibility. The Cisco Finesse desktop supports features that improve accessibility for low-vision and
vision-impaired users.

●

Increased capacity of phonebooks and contacts. Cisco Finesse Release 11.0(1) increases the
maximum number of team phonebooks from 50 to 300 and total contacts in all phonebook s from 1500 to
50,000.

Cisco MediaSense
Cisco MediaSense is an open-standard, network-based, scalable platform that supports recording, playback, live
streaming, and storage of media, including audio and video, with rich recording metadata. It gives you an efficient,
cost-effective platform for capturing and storing conversations with your customers.
New with CSR 11.0 (Cisco MediaSense 11.0):
●

In-browser playback. In addition to Java media player, you can play back an audio recording using the
HTML5 playback feature of the browser.

●

Cisco Finesse AgentInfo gadget. The AgentInfo gadget can be configured on the Cisco Finesse agent
desktop to convey agent information from Cisco Finesse to Cisco MediaSense. The agent information
includes login ID, login extension, first name, and last name. It also keeps a track of the agent sign -in and
sign-out times.

●

Agent information in Cisco MediaSense Search and Play. You can search for recordings based on
agent information and view agent information in the search results. The agent information includes login ID,
login name, first name, and last name.

●

Cisco Unified Communications Manager line display name in Cisco MediaSense Search and Play.
Enter the line display name in the Line Name text box to search for a recording.

●

Call association for network-based recording and Cisco Unified Border Element dial-peer recording.
Cisco MediaSense 11.0(1) supports call association for Cisco Unified Communications Manager network based recordings and Cisco Unified Border Element dial-peer recordings.

●

Search on archived recordings. You can search archived recordings in Cisco MediaSense Search and
Play using the Archive Calls tab. Use the session ID, participant ID, and date range to search the archived
recordings.

●

Video greeting upload. Cisco MediaSense integrates with Cisco Unity Connection to store and play back
video greetings through the telephony user interface.
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Cisco SocialMiner
Cisco SocialMiner is a social media customer-care solution that can help you proactively respond to customers and
prospects communicating through public social media networks such as Twitter, Facebook, and other public
forums or blogging sites. By providing social media monitoring, queueing, and workflow to organize customer posts
on social media networks and deliver them to your social media customer care team, your company can respond to
customers in real time using the same social network they are using.
New with CSR 11.0 (Cisco SocialMiner 11.0):
●

Discard an email message. Cisco SocialMiner Release 11.0(1) provides this feature for Cisco Unified
Contact Center Express. This feature allows email support agents to discard spam and trivial email
messages that do not warrant a response. This feature requires Cisco SocialMiner integration with Ci sco
Unified Contact Center Express and is delivered through Cisco Finesse.

Cisco Unified Customer Voice Portal
The award-winning Cisco Unified CVP provides IP-based self-service and call routing. It combines open-standards
support for speech with intelligent application development and call control to deliver personalized self-service to
callers, either as a standalone IVR system or transparently integrated with a contact center.

Why Cisco?
When you choose Cisco, you benefit from our expertise as a global l eader in collaboration and cloud solutions.
With the broad Cisco product portfolio and a commitment to open -standards solutions that work smoothly together,
you can begin using Cisco Collaboration Systems Releases with confidence.
For more information about Cisco Collaboration Systems, please visit Cisco Collaboration Systems.
Documentation.

Cisco Capital
Financing to Help You Achieve Your Objectives
Cisco Capital ® can help you acquire the technology you need to achieve your objectives and stay competitive.
We can help you reduce capital expenditures . Accelerate your growth. Optimize your investment dollars and ROI.
Cisco Capital financing gives you flexibility in acquiring hardware, software, services, and complementary third party equipment. And there’s just one predictable payment. Cisco Capital is available in more than 100 countries.
Learn more.
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